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Apple Menu

The Apple menu gives you access to developer
information, on-line help for ModelPro, and desk accessories. 

About ModelPro 3.0

Displays the splash screen which you see briefly upon
launching the application. Simply click anywhere on screen to return to
ModelPro.

Help…

Gives you access to the on-line help for ModelPro.
Follow the instructions for navigating in the Help file to locate the
information you want. This easy-to-use on-line help is a good companion
piece for the printed Reference Manual. 

Desk Accessories

You get normal access to all of your desk accessories. 

File Menu

The File menu gives you access to the most basic file
generation and maintenance functions. In addition to these basic
functions, you may open non-ModelPro databases, open ModelPro
databases as Library files, import Postscript line art, save your model 
in a non-ModelPro format, and transfer to Presenter for animation 
and rendering. 

New

The New command performs three functions: 1) makes
the current database inactive (invisible), 2) opens a new, untitled database
with all settings reset to default, and 3) creates a new Menu (Model) at
the top of the screen next to Operations. The Model menu lists all of the
current (not Closed) databases. Highlight the name of the database you
wish to work on to activate it.

Open…

This command opens an existing ModelPro file.
Choosing Open presents you with the standard Apple Open 
dialog box. A Presenter Professional 1.5 file may be opened, and will be
converted to a ModelPro 3.0 database.

Note: Keystroke equivalents appear
next to commonly used commands,
allowing you to work more efficiently.
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To Open a file:
In the standard Open dialog box, click on the file name to highlight it, then 
click on the Open button; or simply double-click on the name.

Opening a file de-activates the current active file and creates a new Menu (Model)
described above under New. 

Close

Closes the current active file. If you attempt to Close a
file that has not been saved since making changes, you will be prompted
to do so.

Save

This command saves the current file to the location from
where it was loaded, updating the original file. To save without
overwriting the original file, choose Save As… and specify a different
file name. If this is the first Save of a new database, you will be presented
with a dialog box identical to the one shown under Save As…

Save As… 

The Save As… command is used when renaming an
altered file to preserve the original, when first saving a new file, or when
saving a file in a non-ModelPro format. If you designate a name that
already exists on the disk, ModelPro will present a choice to either
overwrite the old file or select a different name for the new one. The
Save As… command is also used when the current file must be saved to a
different folder or disk. Use the Desktop button to switch to a different
disk and the Location pop-up menu to return from nested folders. 

ModelPro currently supports one file format—the native ModelPro 3.0
database format.

To save a file with a new name, or a New file
1) Select Save As… from the File menu.
2) Choose the file format desired from the File Type pop-up menu.
3) Select the disk destination, then click on the Save button.

Tip: Use Save As… to save multiple
revisions of a ModelPro file at its
various stages of development. These
“extra” files are helpful if you encounter
a system crash or any mishap which
destroys the current database. 

Note: It is recommended that you
periodically save working files to
prevent the loss of an entire file due 
to a power failure, etc.
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Revert to Saved

Resets the database of the current active file back to the
way it was at the last Save. This is useful when serious design errors
occur that cannot be undone.

Open Library…

This command opens an existing ModelPro file.
Choosing Open Library… presents you with the standard Apple 
Open Dialog Box. Files opened in this fashion will be listed in the
Libraries Palette. 

Page Setup…

This is the standard Macintosh Page Setup command and
is used to set the page characteristics for your printouts. The dialog which
is displayed varies depending upon the type of printer being used. The
options for the ImageWriter® includes page orientation, page sizes, and
reduction. The Apple LaserWriter® page setup also includes enlargement,
font substitution, smoothing and fast bitmap printing. Please refer to your
printer manual for additional information.

Print…

This command prints selected views and information on
the active printer or to a file on disk. The windows to be printed can be
tiled on one page or printed on separate pages. The Page Preview will
display the page layout. There are two options
when printing one page per object window:

Enlarge Window to Paper - enlarges the window
printed on that page so that it fills the entire page.

Use Window Scale & Centering - this option
prints the desired window(s) at the scale and
position shown on-screen. A line measuring 
three inches on screen will measure three inches on
paper.

Print dialog box
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Render/Animation…

Render/Animation… command transfers control from
ModelPro to Presenter for animation and rendering. 

Quit

This command exits ModelPro and returns you to the
Macintosh desktop. If you attempt to Quit a file without saving changes,
you will be prompted to do so.

Edit Menu

The Edit menu contains commands for screen data
manipulation. This menu allows you to Cut, Copy,  Paste and Duplicate
selected items from your database. ModelPro allows Undo/Redo up to 10
times through this menu. Additionally, access ModelPro’s Preferences to
fine-tune your interface for an efficient modeling environment.

ModelPro uses its own clipboard for moving 3-D data and does not
support the Macintosh clipboard. This means that ModelPro’s
information cannot be pasted into other programs.

Undo

The Undo command negates the most recent action
performed on the database. You may undo up to 10 actions by selecting
Undo or typing -Z.

Cut

The Cut command removes the current selected item
from a design and places it in a temporary ModelPro clipboard (not to be
confused with the standard Macintosh Clipboard). All attributes
pertaining to that group are removed from the current database. Cutting a
folder removes all elements contained in it. If a folder or element is Cut
unintentionally, you can return it with the Undo or Paste command. Each
time the Cut command is used, the cut selection replaces anything
previously in the ModelPro clipboard.

To use the Cut command
1) Select the item to be cut. You may also select the item name in the Group 

Info Palette.
2) Select Cut from the Edit menu or type -X to execute the command.
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Copy

The Copy command works like Cut, but does not remove
the item from the current design. A copy is placed in the ModelPro
clipboard for later placement in the same or different design. The copied
data replaces anything previously in the ModelPro clipboard.  

To use the Copy command
1) Select the item to be copied. You may also select the item name in the 

Group Info Palette.
2) Select Copy from the Edit menu or type -C to execute the command.

Paste

The Paste command places the last Cut or Copy
(ModelPro clipboard item) into a model database. The data remains in the
ModelPro clipboard and can be pasted as many times as needed (this
manner of duplication can save valuable time in designs requiring
repetition of a single item). The pasted item will be located at its position
when it was copied to the ModelPro Clipboard. 

To use the Paste command
1) Select Paste from the Edit Menu or type -V to add the item in the 

ModelPro clipboard to the current database. The item is then discreet 
from other items and may be edited the same as any other item in 
the database.

Clear

Clear works like the Cut command but does not save the
cut elements in the ModelPro clipboard. Instead, Clear removes data
permanently from a model. If a group is cleared unintentionally, it can
only be returned by using Undo.

To use the Clear command
1) Select the item to be cleared. Select Clear or type -B to execute 

the command.

Select All

Select All selects all the elements of the model. Any
operations which you perform will effect all elements of the model. The
keyboard equivalent is -A.
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Clone

Makes a copy of the selected item in the same location as
the selected item.

To use the Clone command
1) Select the item to be cloned.
2) Select Clone from the Edit menu or type -W.

Duplicate…

Gives access to a dialog box for entering numeric
information required to complete a Linear or Polar duplication. Select
Duplicate… from the Edit menu, or type -= to access the dialog box.
Duplicate operations may be performed intuitively using the Linear- or
Polar-Duplicate tools located in the Tool palette.

The Duplicate dialog box

This dialog is used
for making multiple copies of a
selection with a translation and a
rotation for each copy. A new folder
is automatically created and all of
the copies, including the original
object, appear in that folder. 
There are a number of options which
affect the way the duplicate
command operates. Most of them are
applicable to both Linear and Polar
Duplication.

Total #–Use this field to indicate how many total objects you want
(including the original) after the duplication operation is complete. (The
default is 2.) If you enter a very large value for Total # (by mistake or
not), you can use ‘Command-period’ to abort this operation.

Move–These three data fields define an offset vector that is used for
moving the copied object(s) relative to the original object.

Duplicate dialog box
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Resize–Each of these three data fields specify a value that ModelPro will
use to resize the selected object(s) in each of the three axis. They are in
the form of a ratio, so values smaller than 1.0 will reduce the size of the
object(s) and values greater than 1.0 will enlarge the objects. For
example, to make each of the new copies half-again as big as the
previous copy, put a value of 1.50 in each of the three resize data fields. 

Rotate–When using the Polar Duplicate mode, the values in the Top (xz),
Front (xy), Right (yz) data fields determine how much rotation will 
be used for the duplication operation. The rotation defined by each value
occurs in the plane of the window for which it is defined. 
The Incremental and Distributive radio buttons define whether to use the
specified angle as the amount to rotate each copy relative to the 
last, or as the total rotation of all the copies. When using the Linear
Duplicate mode, the Rotate Copies check-box must be checked in order
for each copy to be rotated in addition to the linear offset that is defined.

Rotate Copies–when this option is checked, each copy will rotate about an
axis of rotation that goes through the point that is defined as the Center of
Rotation.

Center of Rotation–This pop-up menu has several commonly-used points
that can be used as a Center of Rotation. The X, Y, Z data fields allow an
arbitrary point in space to be set for the Center of Rotation. If a choice
from the pop-up menu is used, then the values of this point are
automatically entered by ModelPro into the Center of Rotation 
data fields.

Method–These two radio buttons allow you to define the type of
duplication that is to occur.

Polar–This mode sets ModelPro to do an angular duplication of
the selected objects about the Center of Rotation. Most commonly when
using this mode, the Move values will all be zero. But an offset could be
defined to be included in a polar duplication.

Linear–This mode sets ModelPro to do a linear, or vector-based
duplication of the selected objects. Most commonly when using this
mode, the Rotate values will all be zero. But the objects could be caused
to rotate along with the linear duplication.



1:8

Distribute–These two buttons allow you to define how ModelPro will
interpret the data in the Move and Rotate Copies data fields

Incremental–Moves each of the copies the distance shown in the
Move data fields. —and— Rotates each of the copies the angular amount
shown in the Rotate Copies data fields.

Distributive–Distributes the total number of copies over the
distance between the selection’s original position and the offset shown in
the Move data fields. —and— Distributes the total number of copies over
the rotational angle between the selection’s original position and the
angle shown in the Move data fields.

Rotate Copies–If this field is checked, then the selected object(s) will
rotate according to the values in the Rotate Copies data fields while a
linear duplication operation is carried out. This check-box has no effect
when the Polar button is picked.

Resize Affects Rotation–If this field is checked, then the selected object(s)
will resize according to the values in the Resize data fields during a polar
duplication operation.

Default Values–sets all values back to the original values.
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Preferences…

Gives access to dialog boxes for entering numeric
information required to to fine-tune the ModelPro interface. 
The Preferences dialog boxes are: General, Screen, Drawing, Grid, 
and Colors. 

General

Beep After Long Functions–ModelPro will beep 
once after finishing any function which takes 
over 3 seconds for the program to accomplish. 
This is done so that when you do not happen to 
be looking right at your computer when the
operation is finished, you get an audible alert 
to signal you.

Auto-Update Library Items–Library objects will use
newer information, if available.

Delete Spline After 3-D operation–This will remove the spline that an
operation is based on. For example, if this check-box is not checked,
when you Extrude an ellipse, a new extrusion object gets created, and it
appears in the Group palette. The original ellipse is still there, but it is
automatically changed to be invisible. (The black box in the “D” column
turns to white for the ellipse.) This allows you to go back and work with
the original ellipse later for any reason. But, if you put an “x” in the
check-box, then when you extrude the ellipse, the new extrusion object
still gets created, but the original ellipse object gets deleted from the
Group palette. 

3-D Operations Create Folders–This will put the original spline and the
operation result into a new folder. The original spline is also “turned off.”

Faster Spline Drawing–This will draw splines in a more jagged way.
However, this will enable the display to be faster.

Facet shading for Angled view–This is slightly faster and displays shading
at the facet level. In some cases, this allows you to see the geometry 
more clearly.
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Relax Clipping in Quick Render–It is possible to zoom in so close to an
object that the object will not display; it will be “clipped.” Enable this
check box to ease those restrictions on zooming. Warning: you may
encounter other problems when zooming “too close” to an object.

Screen

1, 3, 5 Pixels (radio buttons)–these let you choose
the size of your vertices based on the number of
pixels. Larger vertices make it easier to determine
the state of each vertex (is it visible or selected?)
but this can clog up the view when there are lots of
vertices to display.

Origin Lines–If there is an “x” in this box then ModelPro displays axis
lines through absolute 0,0,0 in all the view windows. The option is on 
by default. 

Depth Lines–If there is an “x” in this box then ModelPro displays dotted
axis lines through a temporary “depth origin.” This depth origin moves
each time the space bar is hit while the cursor is in one of the orthogonal
view windows.

Axis Indicators–If there is an “x” in this box then ModelPro displays a
graphic in the lower left side of the drawing windows showing the
orientation of the coordinate axis in each of the orthogonal view
windows. These are the small arrows with “xz,” “xy,” and “zy” labels. 
This option is on by default.
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Drawing

Scale Options–The Scale options provide the ability
to set the data accuracy and units used.

Decimal Places (pull-down menu)– This
lets you vary the data accuracy display by factors 
of 10: 1.0, 1.00, to 1.00000000. This is the
precision of the numbers that are displayed in 
the data fields throughout ModelPro. This setting
does not affect the fact that ModelPro is keeping
track of your geometry with full floating point 
precision regardless of how the display setting 
is made.

Units (pull-down menu)–lets you design your drawing in the units
which are most appropriate for the model you are constructing. Note: The
“Feet” option uses feet and fractions of inches.

Cursor Types (radio buttons)–The cursor usually used for the drawing
tools in the drawing windows is selectable using this option.

Arrow

Crosshair

Bullseye

Window Crosshair

Multi-Window Crosshair

Decimal Places pull-down menu

Units pull-down menu
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Grid

Grid Options–These define grid spacing, visibility,
and locking.

Visible Grid (check box)–will display a grid, with
the spacing determined by the data fields, which
will not affect the drawing tools and is only visible
for guidance. 

Snapping Grid (check box)– places an invisible
constraining grid over the drawing surface to which all cursor controlled
actions will snap when the Grid snap option in the Snap palette 
is activated.

Link: Y  Z (check boxes)–when these are checked, the program
will use the values of the X axis data fields, and will automatically assign
those for the Y and Z axes as well. When these are unchecked, the three
data fields are allowed to act independently.

Colors

Background–Background color for all windows

Depth Lock–Color of depth lines going through the
Depth Origin.

Camera Window Grid–Color of the Grid in the
Angled window

Drawing Window Grid–Color of the Grid in the Top,
Front and Right windows
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Origin–Color of the zero lines going through 
the absolute Origin (0,0,0).

Guides–Color of guides

Markers–Color of markers

Default Drawing Color–Color that is set in the Color
palette by default. This will be the color of any new
objects that are created.

Windows Menu

The Windows menu controls on-screen display of the
Windows and Palettes in ModelPro, as well as allowing access to
finished still images and animations from Presenter 3.0.

Re-display

This command re-displays the images shown in the
Top/Front/Right and 3-D View Windows. You will find many instances
in which the images are not redrawn after operations; -D is the
keyboard equivalent for Re-display, and should be one of the first that
you memorize and use often.

Top / Front / Right / Angled Window

Each of these commands performs two functions in
association with the Window it shares its name with: 1) if the Window
has been closed, it opens the Window and makes it the current active
Window; 2) if the Window is open, but not the current active Window, it
makes the Window the current active Window. In case 2, this command
would be used in place of clicking in an open area in the appropriate
Window with the Selector tool.

Standard color edit dialog box
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Palettes

This displays a sub-menu listing the
seven palettes available to you in ModelPro: Statistics,
Tools, Snapping, Groups, Tool Info, Status Line, and
Libraries. Selecting any one of the list items enables the
display of the corresponding palette. If a check mark
appears to left of the list item, the palette is currently
displayed and active on-screen. To close a palette click
on the Close box in the upper-left corner of the palette.

Image/Movie…

This command allows you to view already completed
renderings of Presenter Professional 3.0 files for reference. Choosing
Image/Movie… presents you with the standard Apple Open dialog box.
Locate the file you wish to open and select Open, or double-click on 
its name. 

Click-hold on the title bar of the image window to expose the option to
put the image into the data base, and use it as a template which may be
moved, rotated and resized.

Clean-Up Windows

The Clean-Up Windows Command returns the
arrangement of the Windows and Palettes to the default arrangement you
see upon application launch. Note that if an old model is opened and does
not fill your larger screen (or clips Windows and Palettes on your smaller
screen), Clean-Up Windows rectifies this situation.

Options

The Options menu controls the display of Rulers, Guides,
Grid, Depth Line, and Markers. If a check mark appears to left of the
menu item, the item is currently displayed and/or active on-screen.

Show  Ruler / Guides / Grid / Depth Line / Markers

Each of these commands enables/disables the on-screen
display of the item which shares its name. 

Snap To Guides

When Snap To Guides is checked, drawing tools will
snap to guides when they are within a 3 pixel distance. This option is also
available in Snap Palette (the top-right box).
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Lock Guides

When Lock Guides is checked, no guides may be moved
or deleted, after placement, until Lock Guides is unchecked. Locked
guides will be removed if Clear All Guides is selected.

Clear All  Guides / Markers

Removes all Guides/Markers from the View windows.
There is no check mark associated with this function. Simply select the
menu item to activate it.

Group

The Group menu automates some functions which can be
performed in the Groups Palette, as well as providing access to Object
Info dialog boxes.

Group

The Group command combines two or more items
(groups and/or objects) to make it possible to select and edit the items as
one. When the Group command is used, a new folder is created in the
Groups Palette containing the selected items. For more detailed
information regarding folders and groups see the Group palette chapter in
this manual.

To create a new group
1) Select the items you want to group, then choose Group from the 

Group menu ( -G).
2) Enter a name for the new folder.
3) Click Add.

Ungroup

The Ungroup command splits the items (groups and/or
objects) from their group structure (folder) back into discreet items
(groups and/or objects); the folder is deleted from the Groups Palette.

To ungroup
1) Select the group you want to split, then choose Ungroup from the 

Group menu ( -U).
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Create Folder

The Create Folder command inserts a new, empty folder
at the Insertion Pointer in the Group palette.  A Folder is a structure
which can hold other Folders and Objects.

To create a new folder
1) Select Create Folder ( -F) from the Group Menu.
2) Enter a name for the folder.
3) Click Add.

Information

The Information command accesses the Information
dialog box for the selected item (group or object). You may accomplish
the same function by double-clicking on the item name in the Group
palette, or on the item in a View window with the Selector tool.

Operations

This Menu gives you access to some very important
dialog boxes used to precisely position your model, and to Join two or
more separate elements.

Transform…

Highlight this  item to access the Transform dialog box.

The Transform dialog box

The Transform dialog allows you to make multiple
specific adjustments to the placement and size of selected elements. 

When the program does the Transform it does the operation in a specific
order which can affect how the selection will be changed. The order is
Resize, Rotate, and then Translate. 

Translate: X,Y,Z–Moves the selection the desired distance. The values
typed in here are treated as offsets. The values are not read as absolute
coordinate locations relative to the origin.

Rotate: Top, Front, Side–Rotates the selected object(s) the amount set 
in the data fields. The rotation takes place about the point set in the
Center of Transform section of this dialog box.
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Resize: X,Y,Z–has two options. Sets the dimensions
of the selection to either match the size in the data
fields, or changes the size according to a factor that
is in each of the data fields.

Ratio–multiplies the size of the selection
by the contents of the data fields. To make the
object(s) enlarge, use a value greater than 1.0. 
To reduce the size of the object(s), use a value
smaller than 1.0.

Actual Size–adds or subtracts what is
needed to make the selection fit the values in 
the data fields.

Center of Transform–The coordinates entered here
define the axis point for the Rotate function and
the anchor point for the Resize function. There is a
pop-up menu that contains several pre-defined
reference points whose locations can be used as a
center point. You can also enter any values for the
x,y, and z data fields to define the location you
want for the center point. 

Pull-down menu

User’s Choice–The user enters a coordinate set to define the
Center of Transform point.

Rotation Point–Uses the Rotation Point, as defined by the
Information dialog for the selected object or group.

Selected Vertex(s)–Finds the geometric center of the selected
vertex(s) and uses that as the center point. If only one vertex is selected,
then that is used.

Center of Object(s)–Finds the volumetric center of the selected
object or group and uses that as the center point.

Galactic Core–uses the Origin (0,0,0) of the drawing universe.

Default Values–Sets the values in all of the data fields back to the default
values that come up when ModelPro is first launched.

Transform dialog box

Center of Transform pull-down menu
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Join Elements

Use this function to join separate 2-D shapes.

To join 2 or more shapes
1) Select the shapes to join. Use the Shift key to make multiple selections.
2) Choose Join Elements in the Operations menu.

If you are trying to join the ends of spline shapes, the ends to be joined must be  
very close to, or directly “on” one another. 
The original spline shapes are deleted from the Group palette (and the database) 
and are replaced by the new, joined item titled “Joined Splin.”

Joining two, closed 2-D shapes is only useful if: 1) both shapes are in the same 
plane, and 2) one of the shapes is completely “inside” of the other. The result is that
the smaller of the two shapes acts as a hole in the surface of the larger shape. 
The display of the original shapes is disabled in the Group palette, and a new item is 
created, and displayed, titled “Joined Splin.”

Align…

Highlight this menu item to access the Align dialog box.

The Align dialog box

The Align command
allows you to take a selection of
objects and arrange them in space
relative to one another in a very
controlled way.

X,Y,Z (check-boxes)–Determines the
choice of axis which the selection is
going to be aligned to or distributed
along. To activate an axis, put an “x”
in its check-box by clicking on it. A
sample 3-D space is shown to
represent what the results of the 
alignment settings will be.

Align–Sets up all the selected items so that they are lined up along a 
single line.

Distribute–Takes the selected items and spreads them out evenly between
the two items which are farthest apart.

Left, Centers, Right, Width (radio buttons) defines what boundary of the
objects are to be aligned.
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Move To…

Highlight this menu item to access the Align dialog box.

The Move To dialog box

Use this dialog box
to move object(s) or groups to a
specific location. You will see a box
representing the bounding box of the
selected object(s). Control points on
this box can be selected to represent
a point within the object space. A
location can then be selected, and all
objects will then translate (move) to
that location.

Section pull-down–Use this pull-down menu to move the sample section
to one of the three default locations in the sample bounding box; Front,
Middle or Back.

Object Extents Box–This is a sample bounding box that allows you to
select one of 27 different control points along the centers and edges of
that space to be used as a reference point for the move operation. Move
the section line with the Section pop-up and select the desired control
point by clicking on it to make it white.

From/To (pop-up menus)–Use these pop-up menus to take advantage of
standard reference points to move the selected objects. Pick the point of
your choice in each of the menus and the object will be moved
accordingly.

Move to (data fields)–The four sets of coordinates are used to 
give information about location of selected points and about the 
move operation.

Current Location–This set of coordinates show the x, y, z values for the
selected control point in the Object Extents Box.

Typical Section pull-down menu

Typical From/To pull-down menu
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Arrows–The four right-facing arrows are used to transfer coordinate 
data from the “Current Location” coordinate set to the “Move To” 
data fields. The top-most arrow transfers all three coordinates at once. 
Each of the other arrows move just that one value.

Last offset–This retains the offset values of the last move operation and
displays them here for reference.

New offset–This shows what the actual offset will be for this move
operation as a result of the settings made in this dialog box.

Again button–This will repeat the move operation, using the values
currently set in the dialog box.


